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What is TimeWizard?

We developped TimeWizard (TW) to allow users to track the time they spend on their 
computer doing things. TimeWizard is especially interesting for:
- Independant Contractors,
- lawyers,
- programmers,
- managers,
- and all the people who use their computer on their workplace.

TimeWizard will keep track of what you are doing during the week and help you see 
what you really spend time on.
Many reports (lists, pie chart, Gantt chart) will enable you to study what tasks are time-
consuming and what tasks aren’t.

With TimeWizard, you can export your data to a spreadsheet application, a database 
application or other applications. Managers will even be able to compile a multi-users report 
compounded of the working time-frames of their employees.
TimeWizard is a productivity tool from Executive Partners Software, a shareware-based 
business.
We hope you will share our enthousiasm about this program and support the ShareWare 
programmers by registering it.

How to use TimeWizard?

When you start TimeWizard, the first thing you will have to do is create a new file. A 
TimeWizard file is a set of projects and time-frames associated with them.
If you are an independant contractor or anyone that will bill the time you spent working on 
your computer, you can use the customers database in your TimeWizard file and periodically
print an invoice.
The last step consists of creating the set of projects you work on to later associate a time-
frame to one of your projects.
Now that your file is setup, just use the ‘Check In’ command in the menu or press the 
button:

to start timing a project.
When you are done working on that project, press the ‘Check Out’ button:



TimeWizard’s screen description

Following is a commented screen shot of TimeWizard:

TimeWizard’s tip
Reducing the size of TimeWizard’s main window will make the Gantt Chart disappear.
Right-click in the Gantt’s Chart allows to:
- change the startint/ending hours of the chart,
- change the week beeing viewed,
- show this screen.

If you right-click on a Gantt’s Chart item, you can also:
- update the item (date, starting hour and duration),
- delete the item.



MemoryAnalyst for Win95

Look on Compuserve (GO MSWIN95, Library General Uploads) and other online services for 
our award winning shareware “MemoryAnalyst”. 

MemoryAnalyst has been designed to help understanding how Windows 95 manages its 
memory.
Once loaded, MemoryAnalyst graphs Virtual Memory and Physical Memory in real-time.
Open and close other applications while MemoryAnalyst is running and see how it affects 
your system's memory.
MemoryAnalyst includes the following features:
- Comprehensive Help File,
- Properties (Appearance and Execution),
- Open/Save file,
- Analysis of data,
- and more...
The Analysis is particularly important since it basically tells you how much RAM would be 
necessary on your system for smooth response from your applications.



File menu

New
The ‘New’ command creates a new TimeWizard file. Each TimeWizard file is a 

different workspace with different projects, customers, ... Most users need only one 
TimeWizard file to work with.

Open
The ‘Open’ command just opens a TimeWizard file. Once you have opened a file, 

TimeWizard will remember it and will automatically reopen that file the next time you use 
TimeWizard. The ‘Open’ command is very useful if you work in team and want to access 
someone else’s file across the network or on a floppy disk.

Export
The ‘Export’ command is typically designed to allow an other application (like 

Microsoft Excel, Microsoft Word, MS-Access, ...) to read TimeWizard files. 
The field separator used is the <TAB> (ASCII 9) character.
The record separator used is the <CR><LF> (ASCII 13,10) caracters sequence.

Properties
The ‘Properties’ command allows to change the application’s user address, the 

invoicing parameters (including sales tax rate) and other parameters (such as the monetary 
symbol and the date format).

Print Gantt Chart
The ‘Print Gantt Chart’ command sends to the printer what you have on screen. In 

addition to the Gantt Chart, a projects legend will appear on the right of your page.

Print Setup
The ‘Print Setup’ command allows to change the printer parameters such as paper 

orientation, page size, ...

Exit
Bye, bye... 
Closes TimeWizard.



Control menu

The control menu consists of 3 items:

Check In

The ‘Check In’ command will present you a dialog in which you will choose the 
project you want to start working on (if you don’t have any project setup yet, see our 
Projects section).
Once you have checked in a project, it will appear in the “Running Projects” window (top-
right part of the screen) with indicators of the time already spent a the money charged to 
the associated customer if any.
You will also notice that the two other Control-commands (Check Out and Pause) are now 
available (see below for details).

Check Out

The ‘Check Out’ command closes a working session on a project that is being timed. 
The time you spent working on a project will only appear in your reports (summary of 
charges, Gantt Chart, Projects Pie, ...) at the moment you check out from it.

Pause

Leaving the office for a coffee, lunch or to play your favorite computer-game...Press 
the ‘Pause’ button and TimeWizard will know you are out. When you return working on your 
project, just press ‘Pause’ again and TimeWizard will resume timing your work.

TimeWizard’s Tips :

There are 2 other ways to access the Control-commands : the check in, check out and
pause commands are also available as buttons in the toolbar. For convenience, since 
TimeWizard will be minimized (present in the taskbar only), you can call the system menu by
right-clicking TimeWizard’s icon in the taskbar and directly access the Control-commands.

With TimeWizard, it is possible to check in up to five different projects at the same 
time. This is especially useful if you work on something generic and want it to be billed to 
many customers at the same time (not very ethical... but after all, we were born with two 
hand, two legs, two eyes and a multi-tasking brain, isn’t it?)



Customers menu

Edit Customers
This command allows to add, update or delete customers. If you don’t use the 

invoicing capabilities, you won’t need to create customers.



Projects menu

Edit Projects
This command allows to add, update or delete projects. a right-click in the projects 

window will prompt a popup-menu with the options of creating a new project or sub-project. 
If you right-click on a project, the popup-menu will contain contextual commands 
(update/delete project). Sub-projects are only a visual manner of organizing your projects.

Projects Pie Chart
Graphically show the weight of each project in you overall working period. You may 

change the graphed period to any time-frame. Move your mouse on the pie to see a bubble 
indicating the project’s name and according time spent working on it.

TimeWizard’s Tip :

In the projects window, you can use the drag and drop capability to change the order 
of your projects in the list.



Reports menu

Edit Projects
This command allows to add, update or delete projects. a right-click in the projects 

window will prompt a popup-menu with the options of creating a new project or sub-project. 
If you right-click on a project, the popup-menu will contain contextual commands 
(update/delete project). Sub-projects are only a visual manner of organizing your projects.

Projects Pie Chart
Graphically show the weight of each project in you overall working period. You may 

change the graphed period to any time-frame. Move your mouse on the pie to see a bubble 
indicating the project’s name and according time spent working on it.

TimeWizard’s Tip :

In the projects window, you can use the drag and drop capability to change the order 
of your projects in the list.



How to register?

TimeWizard® 1.0
Credit Card Registration(MasterCard, Visa, American Express, and Discover): you 
can use the PsL Credit Card Registration service: Order by Credit Card.

CompuServe Registration: To have the registration fee added to your CompuServe bill 
use the CompuServe command GO SWREG and follow the menus. TimeWizard95’s 
registration ID is 10122.
$24.95 will be added to your next Compuserve invoice.

Ordering by check: To order by check, send this order form and a check to B. D’Andrea. 
Payment must be in US dollars drawn on a US bank, or you can send international postal 
money orders in US dollars (see our address in this Help file Contents).

When you register: you will be sent a registration key that removes the UNREGISTERED 
message and 
also removes the 30 days trial period lock. We will keep you informed of new versions as well
as our other upcoming exciting products.
Comments are welcome. Registration keys will be sent by E-MAIL if you provide one, 
otherwise by regular mail.
The EP Soft team thanks you for your support.

FRANCE residents: To order by check, send this order form and a check to EP SOFT of 
129FF drawn on a French bank (see our address in this Help file Contents).

Customized version of TimeWizard: if you like TimeWizard but would like to have some 
enhancements to accomodate your company (additional reports, custom export format, new
features, ...), E-mail us the desired changes and we will reply to you with a cost estimation.

Look for the other great EP Soft sharewares:
MemoryAnalyst



Order Form

To print this form, click on Print Topic in the File pull-down menu.

Fill and send this form to us by mail, fax or E-Mail (see our address in this Help file Contents):

I want to register ___ copies of TimeWizard at $24.95 each = _____

Total payment : _____

Name : __________________________________________
Company : __________________________________________
Address : __________________________________________
City : __________________________________________
State : __________________________________________
ZIP : __________________________________________
Country : __________________________________________
Phone : __________________________________________
Fax : __________________________________________
E-Mail : __________________________________________

Comments about TimeWizard :
________________________________________________________
________________________________________________________
________________________________________________________
________________________________________________________
________________________________________________________

Site licenses available at lower rates.
Dealers, contact us.



Credit Card Order Form

MasterCard, Visa, American Express, and Discover orders for TimeWizard must be placed 
through PsL, a credit card order taking service.    You can reach PsL 24 hours a day 7 days a 
week by fax at 1-713-524-6398, by CompuServe mail to 71355,470, or Internet mail to 
71355.470@compuserve.com.    You can also call PsL at 1-800-242-4PsL(4775) or 1-713-524-
6394 between the hours of 7:00 am and 6:00 pm CST Monday-Thursday and between 7:00 
am and 12:30 pm CST on Fridays, except holidays.
Credit card orders can also be mailed to PsL at 
PsL
P.O. Box 35705, 
Houston, TX 77235 
USA.

To register by credit card, please fill the following form and E-Mail, fax or send it to PsL. You 
will receive your password by E-Mail or regular mail (if you don’t provide an E-Mail address) 
to unlock your Evaluation Copy.
If you don't have an Evaluation Copy of TimeWizard, we also ship 3.5 inch disks at an extra 
cost of $4.

TimeWizard 1.0 Single Copy ____ copies at $24.95 each = ______

TimeWizard 1.0 Site License
    2 to      9 computers: ____ computers at $20 each = ______
 10 to    24 computers: ____ computers at $16 each = ______
 25 to    49 computers: ____ computers at $13 each = ______
 50 to    99 computers: ____ computers at $10 each = ______
100 to 199 computers: ____ computers at $5    each = ______

[ ] We want to be shipped a 3.5 disk at $4 + ______

Total payment ______

Name: _______________________Date:___________
Company: _______________________________________
Address: _______________________________________
City, State, Zip:  _______________________________________
Country: _______________________________________
Phone: _________________Fax:___________________
Electronic Mail address: ________________________________

TimeWizard’s PsL product ID is 14468.

How did you hear about TimeWizard? _____________________
Comments:

PsL requires the following information:
Credit Card [ ] MasterCard [ ] VISA [ ] AMEX [ ] Discover
Credit Card Number: _____________________________________
Expiration Date:        _____________________________________
Name On Card:              _____________________________________
Billing Address: _____________________________________

_____________________________________
_____________________________________



EP Soft cannot be reached at the numbers above.    These numbers are for PsL, a credit card 
order taking service only.
For Technical Support or other information see our fax, address
and E-Mail address in the Contents page.

Any questions about the status of the shipment of an order, refunds, registration options, 
product details, technical support, volume discounts, dealer pricing, site licenses, etc., must 
be directed to 
EP Soft
7 rue dur General de Gaulle
91240 St Michel sur Orge
FRANCE 
or by email to 100430,1650 on CompuServe or 100430.1650@compuserve.com on Internet.

To print this form, click on Print Topic in the File pull-down menu.
To E-Mail the form, select the text, click Copy in the Edit pull-down menu,
paste it in your E-Mail software and fill in the blanks.




